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What's New
Fauxmo version 1.2 adds several exciting new features, as well as addresses a few small bugs identified
in previous versions.  Some of the new features include:

* Randomization!  Fauxmo nows has the ability to randomize sections within an Oscillator, the entire
Oscillator, entire Sounds or even the entire Fizmo Preset.  This includes the ability to specify which
parameters in each section to randomize, as well as the ranges within which to randomize those
parameters.  Even Preset and/or Sound names (adjective / noun phrases) can be randomized.  Trust me:
randomization opens up an entirely new set of creative possibilities for sound creation!

* Added FIZMO knob real-time bi-directional control – this includes now correctly storing the state of
the FIZMO knobs within each Preset, something that was not working in previous versions.

* Added new “Info View" window that provides more detailed info about specific parameters and
functions.  A significant amount of these details was gleaned from other Ensoniq documentation, for
example for synths like the MR or ZR series; Ensoniq just omitted a lot of the detail from the Fizmo
manual.

* When performing functions which require sending the entire Preset from Fauxmo to the Fizmo, (e.g.
copy/pasting, changing effect algorithm, changing effect modulation destination, or randomizing),
Fauxmo's user interface operations are now blocked with a grey overlay until the Preset has
successfully been sent.  This prevents too  rapid SysEx transfers from being sent to the Fizmo, which
can cause it to crash.

* Added graphic illustration of signal path flow through effects on the Global Reverb tab – this helps
clarify how signals are routed within the Fizmo, to optimally use it's excellent on-board effects.

For a full list of additions and fixes, see the Version History section at the end of this document.
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Overview & History
The Ensoniq Fizmo is a powerful synthesizer, but much of that power lies locked in parameters that are
not easy (or in some cases impossible) to access from its front panel.  Historically, a computer-based
editor, Emagic's SoundDiver, provided access to all of the Fizmo's parameters for editing, but sadly
that application is no longer in production nor supported on current operating systems, and users who
do manage to get it running (often as a “cracked” application within an emulation of an older operating
system environment) struggle to keep it running reliably, and also have challenges in integrating it
within the rest of their music studio environment.

Fauxmo represents my work in developing an entirely new computer-based editor / librarian for the
Fizmo, and one which attempts to improve upon the original SoundDiver editor.  This represented a
particularly difficult challenge for two primary reasons: (1) the Fizmo's MIDI spec (including both
SysEx and NRPN info) was never published by Ensoniq (the legacy SoundDiver editor was
implemented using direct input from the Ensoniq developers themselves), and (2) the Fizmo uses an
unusual 4 to 5 Bulk SysEx data encoding scheme that Ensoniq developed, obfuscating its SysEx
transmissions and making their interpretation that much harder.

Fauxmo represents the results of a long reverse-engineering process, which included many
components: (1) a working copy of the legacy SoundDiver editor; (2) clues from the Ensoniq MR-
series MIDI SysEx documentation (which was published, and which shares some of the Fizmo's unique
SysEx encoding and other structural features); (3) the building upon of previous attempts at
deciphering the Fizmo that have been documented on the Internet; and (4) assistance from some of the
Fizmo's original Ensoniq team, as well as from the author of the Fizmo module for the SoundDiver
editor (see Acknowledgments & Thanks section for names and details).

The most significant improvement in Fauxmo alluded to above is one which allows for bi-directional
editing of the Fizmo; unlike the original SoundDiver editor, which only allowed for editing within the
application, Fauxmo allows for editing in either the application or on the synth's front panel, with
changes on either being reflected dynamically within both (where possible).  This is accomplished by
using a hybrid of both SysEx and NRPN data exchange between the synth and Fauxmo.

Finally, a word about the name “Fauxmo” - it's pronounced “fomo”, and is meant to be a fun play on
words.  The French word “faux” meaning “fake” or “imitation”, so a “Fake Fizmo.”  But also FOMO
as in Fear Of Missing Out on this awesome synth's full capabilities!
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System Requirements

 Macintosh
• OS X 10.11.6 – 12.x, 64 bit required.  Runs on both Intel and M1 chips.

 Windows
• Windows 7, 8 or 10, 64 bit required

You will obviously also need a MIDI interface to connect your computer to your Fizmo. This MIDI
interface must be capable of reliable, bi-directional SysEx data transmission to your Fizmo. Many
cheap “cable” USB interfaces (MIDI DIN plug on one end, and USB plug on the other, with a “block”
in the middle) are often not capable of this – check its SysEx capabilities with another app if in doubt!

Installation

 Macintosh
The Macintosh version is supplied as a Macintosh disk image file (.dmg).  Just double click the
downloaded file, and you will see a new window appear on your desktop.  Drag the Fauxmo
application icon to the Applications window icon that you see – this will install the Fauxmo application
on your computer:

After the file has copied, you can unmount the disk image, and delete the .dmg file (or keep it
somewhere safe if you'd like, for future installations).

 Windows
The Windows version is supplied as a compressed .zip file.  Unzip the file, and you will be left with a
file called Fauxmo Installer.exe.   Double click this file to run the installer, agree to let the app make
“changes to your device,” and then follow the installer instructions:
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After installation, you will find a shortcut available to launch the Fauxmo application in the Windows
Start menu.
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Uninstallation

 Macintosh – Just drag the Fauxmo application out of the Applications folder to the Trash.

 Windows – Use either the Windows Add/Remove Programs control panel to remove the
application, or use the Uninstall shortcut in the Windows Start menu.
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Authorization & Initial Setup
You’ll need to authorize Fauxmo before being able to use it.  Start the application (please note that
currently, the application takes quite a while to display its user interface – I'll be working on
improving this in the future, but for now please be patient!), and you'll find yourself at the About &
Authorization screen:

Enter your Registration Name and Registration Code, and then click the Authorize button. Be careful,
cApiTaliZation MaTteRs! If successful, the Status field will change to “Registered”, and you will see a
“Use the App!” button, which when clicked will allow you to begin to use the software. If not
successful, you will be left at the Authorization screen to try again.

To verify your authorization status, or to remind yourself of your Registration Name and Code, you can
select the About Fauxmo menu item to be brought back to the About & Authorization screen at any
time.  You can also click the Fauxmo logo in the upper left to do the same thing.

Upon successful first authorization, you'll be placed on the System/Setup tab, where you must set up
MIDI communication with your Fizmo. For Fauxmo to work properly, you must enable the
application to both send and receive MIDI from the Fizmo.  So be sure to select the MIDI device
that corresponds to your Fizmo in both the Fizmo MIDI Input and Fizmo MIDI Output drop down
menus in the MIDI Setup section. Also be sure to specify the MIDI Base Channel that your Fizmo
is set to.

Additionally, you can specify a different MIDI device to send note and/or MIDI clock information to
the Fizmo, to play notes or adjust arpeggiator tempo as you edit a sound's parameters.  The note input
would be useful for example if you have a Fizmo rack (that obviously has no keyboard of its own!), or
if your studio uses a master keyboard controller that is easier to access than the Fizmo's keyboard.  You
do not need to set a MIDI device for these latter two settings (note and clock inputs), it's fine to leave
them as “---” if you have no need for them. Be sure to not set the MIDI Note Input to Fizmo and MIDI
Clock Input to Fizmo settings to the entry corresponding to your Fizmo – this will create a MIDI
feedback loop and things won't work correctly! Your selected MIDI settings are saved between
application sessions.

Once you have set up your MIDI settings, click the Detect Fizmo and Get System Parameters button.
If communication with the Fizmo is successful, you'll see a brief message saying so, the grey overlay
over the System Parameters will disappear, and the Fizmo's current system parameters will be fetched
and displayed on screen.  
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There's one critical step remaining – please ensure that NRPN Transmit Enable is ON.  Fauxmo
won't work correctly if set to OFF.  If it was OFF when Fauxmo retrieved the Fizmo's settings, you
should probably consider storing the change to ON in the Fizmo's flash memory, so you don't need to
repeat this step each time.  See the Usage/System section for more details.

You're now ready to go!  Click the Presets tab to begin.  

On subsequent application start ups, this initial step – detect Fizmo, and if connected automatically
fetch system parameters – happens automatically.  If for whatever reason it does NOT detect the Fizmo
upon startup, you will be automatically brought to the System/Setup screen, will see the grey overlay
over the system parameters, and where you can re-select the correct MIDI devices from the drop down
menus.  You will also be shown the Fizmo Not Detected! warning just under the System / Setup tab.
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Usage

System / Setup

This tab allows one to view and adjust the Fizmo's global MIDI parameters, as well as to set up the
MIDI devices and adjust some Fauxmo options.  Most of the details surrounding initial MIDI setup
were covered in the prior section, Authorization & Initial Setup.

System

These settings allow you to configure global aspects of your Fizmo.  Here are the explanations of each
parameter, copied from page 34 of the Fizmo's User Guide:

These settings are NOT updated dynamically by changes made on the Fizmo; if you do make changes
there, you should press the Detect Fizmo and Get System Parameters button to re-synchronize the
settings.

Also, changes made to these settings will NOT automatically be saved by the Fizmo when it is powered
off.  To do so, follow the procedure outlined on page 34 of the Fizmo User's Guide, and copied below –
basically, press the Fizmo's MIDI Edit button, then the Save button, and then the +/Yes button.
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Note that some of the settings are not mentioned in the Fizmo manual, but do appear in the SoundDiver
settings, and so have been replicated in Fauxmo.  It's still unclear to me whether they have any effect
on the Fizmo or not.

MIDI Setup

This section allows for MIDI set up, to allow for bi-directional communication with the Fizmo to edit
its parameters, and also to provide for an additional MIDI device to be able to send note and clock
information to it.  See the Authorization & Initial Setup section for more details.

If you made changes to your MIDI environment after you've started Fauxmo, you can press the Rescan
MIDI Devices button to update Fauxmo.  You'll need to respecify all the MIDI devices in the drop
down menus if so.

The MIDI Transmit Speed setting allows you to specify a slower MIDI transmission speed, to
accommodate older MIDI interfaces.  In all beta testing, using the Regular setting was fine on a wide
variety of MIDI interfaces.  However if you find that you're having trouble getting the Fizmo to
respond to edits made in Fauxmo, you can try setting a slower transmission speed here.

Randomization and Randomization Preferences

Fauxmo allows for randomization of parameters for a portion of an Oscillator, an entire Oscillator, an 
entire Sound, or an entire Preset.  Note that the on/off status of an Oscillator or Sound is not changed 

by randomization. Click the dice icon  next to each of these to randomize it:

                                                                   
Oscillator section randomize      Oscillator randomize         Sound randomize       Preset randomize

The entire Preset is sent to the Fizmo after each randomization, regardless of how many 
parameters are being randomized.  This will cause the screen to briefly display a grey overlay 
while the transmission occurs, preventing any further sound manipulation until the Fizmo is 
ready.
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The Preferences button in the System/Setup section will open a new window that allows you to specify 
Fauxmo's randomization preferences:

The preferences are arranged by section, which mimic those on the Edit tab.  Fauxmo comes with a
default set of randomization preferences selected, but you can easily specify your own that can be used
each time you run the application.  Simply select which parameters you want randomized, adjust the
ranges within which to randomize between (min and max), and then press the Use Current As Defaults
button.  You can always return to these settings by clicking the Restore Defaults button.  You can also
easily return to the built in defaults by clicking the Restore Built-In Defaults button.  The min and max
ranges for each parameter are constrained to those values allowed by the Fizmo.

Buttons are also provided to allow for quick selection of all or none of the parameters in each section,
as well as for all of the randomization parameters at once.
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Default Preset

Fauxmo allows you to initialize a Preset with a Default patch.  It comes with a Built-In Default Preset,
which is limited to using just one sawtooth wave Oscillator within one Sound, and with no envelopes,
filtering, modulation, reverb, or effects.  It makes for a great “starting point” if you want to build up a
sound from scratch.

If you prefer to use your own custom Default patch, click the Use Custom radio button, this will allow
you to Select a SysEx file from your hard drive for the Preset you'd like to use. Only SysEx files are
permitted, SoundDiver files are not supported. Once you've selected a file, the Preset Name will be
displayed to the right of the Select button:

Application Size

Fauxmo allows you to scale the application window smaller or larger depending on your screen
resolution and personal preference.  If you select a size that it is too large for your current display, you
will be shown an alert instead.  You can set your preference as the default by pressing the Make
Default button – each time Fauxmo is started subsequently, it will open at that size:

Always On Top

Fauxmo allows you to set a preference to always be the topmost application on your screen.  Simply
check the box, and each time you start the application, Fauxmo will always be the topmost window:
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Presets

The Presets tab allows you to manage the Presets that are stored within Fauxmo, to retrieve and send
them from/to the Fizmo, and to retrieve and store Fizmo preset and bank files from/to your computer
hard disk.  Initially, the 64 Preset slots will be empty when you launch Fauxmo for the first time. It's
important to understand that the grid of Presets displayed represents the Presets in Fauxmo – there is
no guarantee that those are necessarily the same as those currently within your Fizmo, unless you've
sync'd them up first, and are sure to only manage them via Fauxmo. 

Get Presets from Fizmo

To synchronize the Presets in Fauxmo with those that are in your Fizmo, click the Get All Presets
button in this section.  If you prefer to fetch one Preset at a time, use the Get Selected Preset (XX)
button; clicking the desired Preset number in the grid will update the button with the corresponding
Preset number.

As the Preset(s) is/are being fetched from the Fizmo, note that the arrow pointing from the Fizmo
image to the Preset grid in Fauxmo will flash.  This is generally true for all data transmission functions
in the Preset tab; the corresponding arrow will flash, so you will know in which direction data is
currently flowing.
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Edit Here and on Fizmo

To edit a Preset within both Fauxmo and on the Fizmo, within its edit buffer, select your desired Preset
from the grid, and click the Edit Selected Preset (XX) button, where XX will reflect the number of the
selected Preset.  You can also double click a cell in the grid to perform this function.  Once the Preset is
transmitted to the Fizmo's edit buffer, the Edit tab will become enabled, and you will be automatically
moved to the Edit screen.

You can also choose to load the current Fizmo edit buffer into Fauxmo's editor for editing – clicking
the Edit Fizmo Edit Buffer will do so.

Finally, you can send the current Fauxmo edit buffer (the Preset being edited on the Edit tab) to a
Preset location on both the Fizmo and Fauxmo.  Select the desired Preset number in the drop down
menu next to Send Edit Buffer to Fizmo and Fauxmo preset, and then click Send to do so.

Send Presets to Fizmo

To send a Preset stored in Fauxmo's Preset grid to a Preset on the Fizmo, click the desired Fauxmo
Preset in the grid, choose the desired destination location on the Fizmo from the dropdown menu (if
different than the Fauxmo selected location, which will be automatically chosen), and click Send.

To send all of Fauxmo's Presets to the Fizmo, click the Send All Presets button in this section.

SysEx

You can load an individual SysEx file to a Preset location in Fauxmo.  Simply select the desired Preset
slot in the grid, and then click the Load Preset from Disk to Selected Preset (XX) Here button, where
XX will equal the number of the selected Preset.  

Pressing the Load Preset Bank from Disk to Presets Here will load a full SysEx bank of 32 patches to
either the Bank 1 or Bank 2 locations, depending on which Bank the file was originally stored from.

Similarly, you can save an individual Preset to a SysEx file on disk by selecting it in the grid, then
pressing the Save Preset (XX) to Disk, where XX represents the number of the selected Preset.

Saving a full Bank to a SysEx file on disk by pressing either the Save Bank 1 to Disk or Save Bank 2 to
Disk buttons.
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You can save a text file containing the Preset names for each Bank by pressing either the Save Bank 1
Preset Names to Disk or Save Bank 2 Preset Names to Disk buttons.

Default Preset

The Default Preset used in this section is either the Built-In one, or a Custom one of your choosing, as
specified in the System / Setup section.

You can load the Default Preset to any selected location in the Fauxmo Preset by grid, by selecting the
Preset location first, then pressing the Load to Selected Preset (XX) Here button, where XX represents
the number of the selected Preset.

Pressing the Load to All Presets Here button will load the Defaut Preset to all Preset slots in Fauxmo.  

Note that loading the Default Presets in this section only loads them locally, to the Fauxmo Preset slots.
If desired to initialize the Fizmo Presets as well, you must do so in the Send Presets to Fizmo section.
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Edit

Once you select a Preset to edit on the Presets tab, the Edit tab activates, and you will be able to switch
to it to view and adjust your Preset. Note that the Preset displayed represents the contents of both the
Fauxmo edit buffer, and the Fizmo's – they will be kept in sync.  Once you finish your sound editing,
it's important to remember that the edit buffer will not be saved, either in Fauxmo or on your Fizmo –
you must save it to a Preset slot if you'd like to keep it.  Do so on the Presets tab, in the Edit Here and
on Fizmo section, by using the Send Edit Buffer to Fizmo and Fauxmo Preset XX button.

When editing parameters, know that some parameters will allow you to reset them to default values by
double-clicking them.  Not all parameters have default values however. 

Also if editing a parameter that has a large range, Command (Mac) or Ctrl (Win)-dragging the
parameter will allow for finer grained control of the value.

Preset Name

The top left of the Edit tab will display the name of the Preset. To edit it, simply click in the box and
make your desired changes.  The contents of the box will turn orange at this point.  To confirm the new
name, you must click the Return/Enter key on your computer keyboard.  The letters will revert to their
usual white at that point.

Sound 1 / Sound 2 / Sound 3 / Sound 4

The first 4 tabs in the Edit section contain the settings for the four Sounds contained within a Fizmo
Preset.  Each Sound has two Oscillators. 

When a Sound or Oscillator is enabled within a Fizmo Preset, you will see an orange indicator in it's
respective tab indicating so.  No indicator means that that Sound or Oscillator is turned off:

You are free to edit any parameter you see on any of these tabs, and the change will be communicated
in real-time to your Fizmo's edit buffer, with changes to the sound occurring either immediately or at
the next note-on, depending on the parameter.  

Clicking each Sound tab to select it in Fauxmo will select the corresponding Sound on the Fizmo's
front panel.  Note that selecting an Oscillator in Fauxmo will NOT necessarily select the corresponding
Oscillator on the Fizmo, however.
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Similarly, you can edit parameters on the Fizmo's front panel, and you will see the change conveyed
immediately in Fauxmo's user interface for the corresponding Sound and Oscillator. There is one case
in which this may not occur however.  The Fizmo sends MIDI NRPN information using “running
status” - practically what this means is that if you make repeated adjustments to a particular parameter
on the Fizmo's front panel, only a partial MIDI message is transmitted after the first change - this is
done to be more efficient. However if Fauxmo was started up after the Fizmo, and that one parameter
continues to be adjusted, Fauxmo does not know how to interpret that “partial” MIDI message and
which parameter it is referring to, and so will not show the adjustment being made on screen. Things
will get back to normal as soon as you adjust another parameter on the Fizmo, causing it to send a full
MIDI message once, prior to resuming the sending of running status MIDI messages.

Copy / Paste

Fauxmo allows you to easily copy and paste portions of a Preset to other parts of that Preset, or even to
entirely different Presets.  In each of the individual sections within an Oscillator (Waveform, Pitch,
Filter, Amplitude, LFO, Env 1, Env 2, Env 3 and General), you will see round graphical C and P
buttons allowing you to copy from or paste into that section, respectively:

If you attempt to paste into a different type of section than the one you copied from, you will receive an
error message:

You can also copy and paste an entire Oscillator, or even an entire Sound.  The copy/paste button
location for each of these operations is shown below:

                                                           

  Oscillator copy/paste buttons                      Sound copy/paste buttons                    

You are also not limited to pasting to other parts of a single Preset – you can paste between Presets as
well.  Pasting sends the entire Preset to the Fizmo, and so will cause the screen to briefly display a
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grey overlay while the transmission occurs, preventing any further sound manipulation until the
Fizmo is ready.

F I Z M O Knobs

The F I Z M O knobs on the front panel of the Fizmo are reflected at the very top of the Fauxmo 
interface, and will reflect the stored values within a Preset after it is loaded. 

They too will remain in sync with the Fizmo, whether parameters are adjusted there on within Fauxmo.
These parameters apply to all Sounds and Oscillators within a Preset.  They correspond to the
following functions, from the Fizmo manual: 

Arpeggiator

As with the Sound tabs, you will see an orange indicator on the Arpeggiator tab when a Preset has the
Arpeggiator turned on.  No indicator means that that Arpeggiator is off.

Unlike on the Sound tabs, changes made to the Arpeggiator's settings on the Fizmo are not reflected in
real time within Fauxmo.  It is therefore best to make all Arpeggiator changes from within Fauxmo, so
the two edit buffers stay in sync.  Also note that some parameters depend on certain MIDI system
settings to be set in specific ways – reminders are included on the Arpeggiator tab page.

Insert Effect

The Insert tab allows you to adjust all parameters of the selected Insert Effect.  If choosing one of the
Fizmo's built-in effect Variations, the detailed Insert parameters will be hidden.  Only when selecting
the “Preset” choice from the dropdown menu, will you see and be able to edit all of the Insert Effect's
detailed parameters.

Note that when making certain change to the Insert Effect (changing the Effect algorithm, or changing
the Modulation Destination selection), the entire Preset must be sent to the Fizmo, and so will cause
the screen to briefly display a grey overlay while the transmission occurs, preventing any further
sound manipulation until the Fizmo is ready.

Global Reverb

The Global Reverb tab allows you to adjust all parameters of the Fizmo's Global Reverb.  If choosing
one of the Fizmo's built-in reverb Variations, the detailed Reverb parameters will be hidden.  Only
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when selecting the “Preset” choice from the dropdown menu, will you see and be able to edit all of the
Reverb's detailed parameters.

A graphic illustration of the signal flow through the Insert Effect and/or the Global Reverb has been
included in this section, as a reminder of what the various input and output parameters do.  The
illustration was adapted from one included in the Ensoniq MR-series synths:

20



Fauxmo – an Ensoniq Fizmo editor / librarian

Info View

Several elements within Fauxmo display an “i” indicator, , letting you know that more information
about that parameter or function is available within the Info View window.  To show it, simply click
the icon.  If the window is already open, simply hovering over a parameter will update the window to
display the appropriate contents.

Virtual Keyboard

Fauxmo has a built-in virtual keyboard, that allows you to send notes to the Fizmo to audition edits
made in real-time.  To use it, click the keyboard icon just to the right of the Edit tab:

Clicking it will turn the icon orange, and you will see an on-screen keyboard appear.  Clicking the icon
again will hide the keyboard.

You can use your mouse to play notes, or QWERTY keys on your computer keyboard, as indicated by
the legend over the keys displayed.  You can shift the octave played by the QWERTY keys by using
the left and right arrow keys on your computer keyboard.
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Documentation & Help
Fauxmo can launch its full documentation (this document) from within the application itself; just go to
the Documentation menu, and choose “Fauxmo Documentation”.  This will launch a PDF viewing
application in which to view the documentation:

On Windows, you can also find a shortcut to the documentation in the Fauxmo Start menu shortcuts.
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About & Authorization screen
The About Fauxmo menu item (in the Fauxmo menu on Macintosh, and in the Help menu on
Windows) will replace the Fauxmo main screen with the About & Authorization screen.  In addition to
the Authorization information described earlier, it shows version and copyright information about the
application, and has direct links to the Fauxmo home and support pages.  You can also get the About &
Authorization screen by clicking the Fauxmo letters on the top left of the purple banner at the top of the
application.

You can also link to the Defective Records home page by clicking its logo on the right side of the
application's purple banner at the top.
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Fauxmo was created using Cycling ‘74’s Max (https://cycling74.com/) software.  In addition, it uses, with
permission, some 3rd party external objects – I'm indebted to their creators for them:

• min.environment, by Tim Place
• stricmp, getpaths, creatfolder, by Jasch

◦ https://www.jasch.ch/dl

◦ Jasch's externals are LGPL licensed, http://www.gnu.org/licenses/lgpl.html 

• bit, Lbyte, by Peter Elsea
◦ http://artsites.ucsc.edu/EMS/music/research/lobjects.readme.html 
◦ Lobjects are Copyright Peter Elsea and The Regents of the University of California. All rights reserved. Redistribution and

use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
▪ Redistributions of source code must retain the above copyright notice, this list of conditions and the following

disclaimer.
▪ Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following

disclaimer in the documentation and/or other materials provided with the distribution.
▪ Neither the name of the University of California nor the names of its contributors may be used to endorse or promote

products derived from this software without specific prior written permission.
◦ THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Thanks to everyone at Cycling ’74 and on the Cycling ’74 forums for their invaluable help with Max
questions.
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Contact & Support
Support Forum
https://defectiverecords.com/forum/categories/fauxmo

Dan Nigrin
dan@defectiverecords.com

Copyright
Fauxmo is Copyright © 2019-2021 by Daniel Nigrin and Defective Records Software. All rights are
reserved.

Version History
Version 1.2.1 (April 23, 2022)

• Fixed Pitch Env Amount parameter to range from -127 to 127, instead of 0-127
• Built with Max version 8.3.0 (4a640222f62)

Version 1.2 (January 5, 2022)
• Added ability to randomize parameters within an Oscillator, the entire Oscillator, entire Sounds

or even entire Preset. Includes ability to specify which parameters in each section to randomize,
as well as ranges within which to randomize those parameters

• Added FIZMO knob real-time bi-directional control – includes now correctly storing state of
the FIZMO knobs within each Preset, something that was not working previously

• Added new Info View window that provides more detailed info about specific parameters and
functions

• Functions which require sending entire Preset from Fauxmo to Fizmo (e.g. copy/pasting,
changing effect algorithm, changing effect modulation destination, or randomizing) now blocks
Fauxmo operation until Preset has successfully been received by Fizmo. This prevents too
rapid SysEx transfers from being sent to Fizmo, which can cause it to crash

• Added graphic illustration of signal path flow through effects on the Global Reverb tab
• Fixed last entry of Pitch Keytrack dropdown menu; now correctly reflects value currently

selected in Sound's Pitch Table.  Thanks to Keith Hess for pointing out the error!
• Level Velocity for Env 3 was not being copy/pasted correctly.  Now fixed
• Rearranged some parameter placements, to be more logically grouped by function
• Incorrect version number was displayed in Mac Get Info window.  Now fixed
• Built with Max version 8.2.2 (1d2bb48dd86)

Version 1.1 (March 31, 2020)
• Added copy/paste ability, for specific Preset sections, entire Oscillator, or entire Sound - even

between Patches
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• Output text file of patch names, on a per Bank basis
• Allows for sending one Bank at a time from Fauxmo to Fizmo, rather than just all patches or

one at a time
• Trigger Mode (General section) was not working properly.  Now fixed
• Osc Delay (General section) was not properly being saved in patch.  Now fixed
• Added preference for "Always On Top" for app window
• Updated Defective Records logo
• Built with Max version 8.1.3 (da28f19)

Version 1.02 (January 1, 2020)
• Added new dropdown menu to select Fizmo's MIDI Base Channel – previous versions didn't

allow the built-in Virtual Keyboard to work correctly to send notes to the Fizmo if it was set to
MIDI channels other than 1

• Built with Max version 8.1.1 (5a2a445)

Version 1.01 (November 10, 2019)
• Added new MIDI selector to choose MIDI clock input to Fizmo – previous version had no

ability to route MIDI clock to the Fizmo
• Multiple minor labeling corrections/tweaks 

◦ On System/Setup tab, "Arpeggiator Tempo Mode" changed to "Arpeggiator Tempo Source"
to match Arpeggiator screen and Fizmo manual

◦ On Arpeggiator tab, "RtPO" changed to "AtPO"
◦ "Username" and "Password" changed to "Registration Name" and "Registration Code" to be

consistent with terms used elsewhere
• Built with Max version 8.1.1 (5a2a445)

Version 1.0 (September 24, 2019)
• First officially released version
• Built with Max version 8.1.0 (8e79f27)

Version 1.0 Beta versions 1-13 (September 12, 2018 – September 20, 2019)
• Versions for external beta tester testing.

Version 1.0 Alphas (December 2017 – September 2018)
• First versions for internal testing.
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